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Introduction    

Make The MOST™ is a sales tool for opportunity selling.  

If each one of your sales is a campaign, that is if it takes 
time and effort to make it happen, then this method is for 
you. If the sales come to you (e.g. in a shop) or each sale 
happens in one event (e.g telephone selling) then MTM is 
not for you (except to help you with bigger deals you may 
do). If your sales are at the other extreme, if you have a 
small number of accounts with whom you maintain a 
relationship and make a series of deals, then MTM is useful 
as one part of your preferred account management system - 
MTM will help you to run those deals but it won't do the 
whole account management for you. If it seems a bit heavy 
for what you do, see MtM Lite at the end of this guide. 

If you are selling, MTM looks at each opportunity in your 
portfolio and assesses it hard, realistically, pragmatically. It 
compares each deal to others. By looking at a dashboard 
across all your opportunities you can make the hard calls 
about where to put your efforts, and where to qualify out. 
By focusing on the most winnable deals you will lift your 
success rate and reduce your cost of sale - when you do 
need resource you'll have no trouble getting it. So you can 
Make the MOST. 

If you are a sales manager, you'll have worked out by 
now that such a tool is equally useful to you as to an 
individual salesman. You can assess each of your team's 
book of business. And you can assess your own portfolio 
across the whole team. Make The MOST of your sales 
team. 

At the heart of MTM is a simple dashboard tool. It uses 
MS-Excel xlsx format. No other software to buy and install. 
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And it is free. There is this MTM User Guide on how it 
works and how to use it, also free.  

What's in it for us? We want to sell you our New Ways of 
Selling training courses, which build on the MTM tool to 
teach you a full methodology for opportunity selling. If you 
want them, after you have tried and proven the MTM tool, 
visit www.makethemostsales.com.  

But all you need for now to start boosting your sales 
effectiveness is the free Make The MOST™ Opportunity 
Dashboard. Try it now and see how simple and effective it 
is at analysing and improving your opportunity sales 
portfolio. 

How it works 

Here's how it works:  

Say you are currently winning 20% of the opportunities you 
chase (or 5% or 50% - it doesn't matter - the principle 
works). 2 out of 10. If you could 

• have more time to devote to each opportunity, to 
make more calls, do more planning, check and 
review letters and proposals and presentations  

• get more access to support resources from your 
company: your boss's time in front of clients, 
technical people, demos and presentations, pilots 
and trials, money for trips and events and meals  

• get some pressure off you (but not too much: some 
pressure is good for winners)  

...If you could have that help, could you win one more of 
those ten opportunities? You can. 

http://www.makethemostsales.com/
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The MTM Opportunity Dashboard gives you an objective 
view of how well you are positioned and how well you are 
progressing with each opportunity. Sit back and study your 
Opportunity Dashboard, often in discussion with your sales 
manager, and kill off two of every ten opportunities.  

Walk away. Save your ammunition. Focus on the other 
eight. Devote resources to those eight. Win 3 out of  instead 
of running yourself ragged getting 2 out of 10. Make The 
MOST of your opportunities and your available resources. 

This is one of the hardest things for many sales people to 
do - to let go of an opportunity that has a pulse (or even if it 
doesn't). Don't flog a dead horse (or an alternative saying: if 
the horse is dead, dismount). Or maybe you get on well 
with them, but the reality is they are never going to buy. It's 
not hard for the best sales people: they know when to 
qualify out. With MTM you will too. 

What if you don’t have enough opportunities to be 
qualifying out, or don’t want to just now? 

MTM will still help you to take a “battlefield view” of your 
opportunities, to see where the serious weaknesses are, 
where to concentrate some efforts. 

In all cases MTM helps: 

You will have more time to devote to each opportunity. 

You will have a formalised objective assessment of your 
opportunity to argue your case for supporting resources. 

You will know where your weaknesses are, where you are 
exposed. You will be blind-sided less often. Sales managers 
don't like surprises. 

Your win rate will go up: in this example from 20% to 
nearly 40% (3 out of 8 remember). Your colleagues back 
winners. You will be asking for resource less often and 
bringing back results more often. 
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You will enjoy selling more. You will Make The MOST. 

 

Here’s a tip: This is only a little book.  For now you 
only need to read pages 5-20.  That’s 16 small pages, 
big type, pictures … won’t take you long. 

Another tip: all the tips are coloured like this. 

Using MtM 

There are many scenarios where you can use this tool: 

• When an individual or team are working on their 
sales planning: which sales to focus on, which ones 
to let go, what needs to be done. 

• When planning a call or visit: what do we need to 
find out or get closed. 

• When making work visible: the status of our 
opportunities. 

• As a discussion tool at sales meetings. 

• When reviewing portfolios to determine where to 
put resources, and which opportunities to drop. 
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Getting started 

If you are reading this, you have probably already 
downloaded the MTM Opportunity Dashboard.  If not, get 
it now from www.makethemostsales.com. 

The Opportunity Dashboard is a spreadsheet.  It tracks 
opportunities, i.e. potential deals.  Don’t put all your leads 
in here.  An opportunity is a qualified live prospect who you 
are dealing with. 

Open the spreadsheet in Microsoft Excel and follow along.   

Tip: The white fields are for you to enter data.  Pale 
blue areas are protected. 

 

 

 

 

 

 

 

 

 

 

http://www.makethemostsales.com/
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Preparing the spreadsheet 

Name 

In the field A3, where it says “name”, enter the name of the 
portfolio of sales opportunities you want to manage.   

This might be your name, or the name of a sales team, or 
the name of one client account. 

Make The MOST™ Opportunity Dashboard

name

 

Quota 

If you want to track progress against quota, enter your sales 
quota (i.e. target) in cell C13.   

Value $,000

Quota $,000 Quota %
 

Tip: We’ve set it up in units of $1000 but you can 
change that (see “Collating spreadsheet”). 

Tip: you might want to use anonymous “code” names 
for you and especially for your opportunities.  That way 
you can share your spreadsheet with other people for 
advice on using the MTM method. 

Tip: check with your organisation before sharing your 
spreadsheet with anyone, whether it is anonymised or 
not. 
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Recording opportunities 

In row 3 is a row of fields.  Name each opportunity in this 
portfolio. 

There is room for 24 opportunities.  That ought to be 

enough for anyone to handle at once ☺  

 

Tip: …but if you are a bit handy with MS-Excel you 
know how to copy and paste new columns  (see “Adding 
more opportunities”). 

Code 

In row 5 you can record any code or number you assign to 
each opportunity. 

Note 

In row 7 you can write some brief comments. 

Tip: if you have set the Traffic Light (see page 11) to 
anything other than green, you really should say why in 
this field 

Close date 

In row 9 you can specify the estimated close date of each 
opportunity.  Enter in whatever format you have Excel set 
up for (usually mm/dd/yy or dd/mm/yy).  It will convert it 
to day-month-year. 
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Today is 1-Aug-09 Close date

Days to go 72

12-Oct-09
 

Row 10 will then display the number of days left.  

Today is 1-Aug-09 Close date

Days to go 72

12-Oct-09

 

Tip: The number of days to go changes colour when the 
date is getting near, or has passed and the deal is late.  
You can change the threshold number of days (see 
Collating spreadsheet). 

Value 

In row 12 you can specify the 
estimated value of each 
opportunity. 

Tip: We’ve set it up in units of $1000 but you can 
change that (see Collating spreadsheet). 

Once you enter a value for 
the deal, if you have 
specified your quota in cell 
C13 then row 13 will now 
display the percentage of quota that this deal represents.   

Tip: You can change the thresholds at which it likes the 
amount of the deal: the percentage field in row 13 
changes colour for medium and big deals (see Collating 
spreadsheet). 

Tip: Cell C23 tells you the total of the percentages of 
quota, i.e. what percentage of your quota all the 
opportunities represent. 

Value $,000

Quota % 13%

400

Value $,000

Quota % 33%

400
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Progress 

There are seven fields in rows 
15 to 21 where you can record 
your progress on the 
opportunity. The spreadsheet 
comes with seven stages 
predefined:  

• emotional (decision 
made) 

• (we have a) solution fit 

• (there is a) business case 

• (we have got decision-maker’s) approval 

• (contract is) signed 

• (solution is) delivered 

• (they have) paid.   

Tip: You can change the names of each step (but not 
how many).  See Collating spreadsheet. 

Tick them off as you go.  The values can be: 

• Empty = not yet 

• Yes = done 

• No = isn’t going to be happening 

Tip: The ‘tick” fields have a selection menu.  Click on 
the field and you will see a little black down-arrow on a 
grey background.    

Click on it 

y

y

emotional

signed

approval

business case

solution fit

paid

delivered
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and you will get a list of possible values. 

Click to choose. 

Or you can type the value in manually straight into the 
field without using the menu at all: type “y’ or “n”. 

Either way the field will colour-code itself green or 
black for yes or no. 

Tip: if you want to return the field to empty (colour 
white), just click on the cell and press delete. 

Assessing an opportunity 

Probability 

In row 23 you estimate a 
probability of winning the 
deal.  

Some people dislike such a subjective number; some 
organisations use them; some even have formal 
methodologies to calculate them. 

Tip: The value is preset to 100% so if you don’t like 
using probabilities just leave it that way.   

This probability affects the “Total % quota” number in 
cell C23.  For each “Quota %” in row 13, it is multiplied 
by this percentage weighting, and the resulting weighted 
percentages are summed to get cell C23. 

Total % quota 43%

 

Probability % 100%
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Traffic Light 

In row 25 you can set a traffic 
light to red, yellow or green to 
indicate how well you (or your 

boss ☺) think the opportunity is tracking.   

Green means all is going well, yellow means cause for 
concern, and red means something needs to be done to 
save the opportunity else it will be lost.  

Tip: this field works by using a selection menu.  Click 
on the field and you will see a little black down-arrow 
on a grey background.    

Click on it and you will get a list of possible values. 

Click to choose. 

 

Tip: if you want to return the field to colour white, just 
click on the cell and press delete. 

Tip: the word “red” “yellow” or “green” appears in the 
field as well as the colour so you can don’t have to print 
in colour. 

Assessment 

You can store up to five assessments for each 
opportunity, in each of the five columns below the 
assessment graphs.  

Using these five columns you can track the history as 
the opportunity develops.   

Traffic light Green

▲▲▲▲▲

5

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0

0
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Tip: if you do more than five assessments for one 
opportunity, you will need to either copy older 
assessments to the left using copy-and-paste, and drop 
the oldest one, or you can keep overwriting the fifth 
column with the latest assessment.  Or if you don’t care 
about history don’t ever use anything but the left-hand 
column and just update it each time you assess. 

There are five groups of five questions to answer when 
assessing an opportunity.  Each group looks at one aspect 
of the opportunity:  

• Relationship Can we influence their decision? 

• Conditions What are we up against? 

• Business Will this get approved? 

• Motivation Do they want to do this? 

• Delivery Can we provide what they want? 

For each question the answers can be: 

• Empty = don’t know (yet) 

• Yes  

• No  

So here’s how to go about an 
assessment: 

Record the date of this assessment in 
the lefthand of the five white fields in 
row 44. Enter in whatever format you 
have Excel set up for (usually 
mm/dd/yy or dd/mm/yy).  It will convert it to day-month-
year.  

▲▲

Assessment Date

5
-A

u
g
-0

9
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Tip: You can use the scrollbar at the bottom right  of 
the spreadsheet 

 

to scroll the opportunities across until the column you 
are working on is next to the questions 

 

Then consider each of the twenty-five questions for this 
opportunity, and work your way down the column 
answering them. 

Tip: The answer fields have a selection menu.  Click on 
the field and you will see a little black down-arrow on a 
grey background.    

Click on it 

and you will get a list of possible values. 

Click to choose. 

Or you can type the value in manually straight into the 
field without using the menu at all: type “y’ or “n”. 



Make The Most™ User Guide  

Either way the field will colour-code itself green or 
black for yes or no. 

Tip: if you want to return the field to empty (colour 
white), just click on the cell and press delete. 

Tip: the fastest way to record an assessment is to 
type “y” or “n” and press enter, which takes you 
down to the next question. 

 

Here is a brief explanation of each question.  For more 
detail and techniques to analyse them, visit 
www.makethemostsales.com. 

R1 influential  
Were we influential in shaping this deal?  Did we 
influence their thinking? 
R2 insider  
Do we have an insider within the organisation who 
will (a) help us, or even better (b) openly support 
us? 
R3 profile  
Do we have a good profile/reputation in their 
organisation? 
R4 power club  
Are the people making this decision part of the 
“power club”, those in the inside circle with the real 
power of the organisation? 
R5 network  
Does our network of connections reach into their 
organisation?  Do we know people there? 
C1 unopposed  
Are they considering or talking to any competition?  
Are there any competitors incumbent or active in 

http://www.makethemostsales.com/
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there?  Do the competitors know about this deal? 
C2 incumbent  
Do we already have any products or people in 
there? 
C3 reference  
Do we have a relevant reference? 
C4 differentiator  
In their opinion, do we have a real differentiator 
from competitors? 
C5 health  
Are they in good shape financially? 
B1 processes  
Do we know their approval processes that this 
deal will have to go through? 
B2 funds  
Do they already have access to funds now? 
B3 business case  
Have we developed a compelling business case? 
B4 contract  
Do we have an existing contract with them that 
this can be appended to or based on?   
B5 project  
Is this a formal project, a planned piece of work? 
M1 milestone  

Is there a milestone to be met, a deadline, a line in 
the sand, an imperative? 
M2 real money  
Does this have hard benefits?  Does it save or 
make them real money? 
M3 reduce risk  
Does this reduce a recognised risk for them? 
M4 strategic  
Is this considered strategic to them? 
M5 winner  
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Will this make the decision-maker and/or approver 
look a winner? 
D1 requirements  
Do we have clear requirements?  Do we meet 
them? 
D2 resources  
Do we have enough available resources to 
deliver? 
D3 risk controlled  
Do we have control over all risks? 
D4 previous  
Have we done this before? 
D5 good business  
Is this good business for us? 

Tip: Your team may soon start to use the question 
numbers as a shorthand code: “Have we got B1?” 

Worksheet 

 

Behind every cold clinical analysis lies a story to be told.  
The MTM Opportunity Dashboard includes a template 
assessment worksheet.  Use a copy of it for each 
opportunity to make a note of why you answered each 
question the way you did.  Especially useful to jog your 

memory when asked to explain them by your boss ☺. 

Tip: if you use it on a tablet or laptop, the Y/N field for 
each question has a dropdown and will colour-code. 

Tip: the worksheet is designed to print out on two 
pages for those who like to work with hardcopy. 
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Reviewing an opportunity 

The MTM Opportunity Dashboard will give you greater 
visibility of where you are really at with each opportunity.   

The objective view helps to decide when to let go, when to 
end APER: Attempted Percussive Equine Resurrection.  
That’s “flogging a dead horse”.  When you don’t have 
enough active opportunities, when a good one has slipped 
away from you, when end of quarter is looming, it is too 
easy to keep flogging the opportunities 
you do have, long after you should let 
them go. 

So answer the questions honestly, then 
sit back and look at the charts for each 
opportunity.  

The charts only show the status of the 
latest assessment.   

The spreadsheet knows which is the 
latest assessment by the right-most date 
field in row 44 that has something (anything) in it (in this 
case “19-Aug-09”).  

The black up-arrow shows which assessment is currently 
displaying in the charts.   

First, in rows 27 to 29, there is a 
summary of how many yes, no and 
unknown answers there are. 

Too many no answers or unknown answers and the total 
colour-codes a warning. 

But we don’t start worrying about unknowns until 40 days 
out from the expected close date.  Before then the total 
stays blank. 

n n n y 0

n 0 0 n 0

n y n n y

▲▲▲▲▲

Assessment Date

5
-A

u
g
-0

9

1
2
-A

u
g
-0

9

1
9
-A

u
g
-0

9

3

n n n n

n n y y

n n n n

y y y y

n n y y

Yes

No

Unknown

9
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Relationship ## ## ## ## 4

Conditions ## ## 2

Business ## ## ## ## ## 5

Motivation ## ## 2

Delivery ## ## ## 3

Relationship y y y n y

Conditions n y n n y
Business y y y y y

Motivation n n y 0 y
Delivery y y n n y

Tip: You can change all the thresholds (see Collating 
spreadsheet). 

Then there are the two assessment charts.  

MTM Bars 

The top five bars are horizontal 
bar-graphs of how many yes 
answers you have under each 
heading “Relationship”, 
“Advantages” etc. 

MTM Grid 

The bottom grid is a map of 
your answers: green for yes, 
orange for blank and black for 
no.  

If there is lots of green then you know you are 
in good shape.  This deal is definitely winnable 
and worth concentrating on.  This assessment 
provides support for requests to your company 
for more resources. 

If there is lots of orange then you don’t really 
know what shape you are in.  You need to put 
in some work to get more information, and you 
need to ask yourself whether this deal is 
winnable in the short term. 

 

And if there is lots of black then you really need 
to ask yourself if this deal is winnable.  Your 
efforts could be better spent on some other 
opportunity, or finding more of them. 

 

## ## 2

0

## 1

0

## 1

0 y 0 y 0

0 n 0 0 0

0 0 0 y 0

0 0 0 0 0

0 0 0 y 0

## 1

## ## 2

## 1

0

## ## 2

0 n n y n

n y n n y

n n n y 0

n 0 0 n 0

n y n n y

## ## ## ## ## 5

## ## ## 3

## ## ## 3

## ## ## ## 4

## ## ## ## 4

y y y y y

n y y y 0

y y 0 y 0

y y y 0 y

y y 0 y y
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Tip: All of the charts – all five rows and columns, the 
whole box – and the summary of how many yes, no and 
unknown answers, they all apply to the one assessment 
with the black arrow above it (it is not one column of 
chart for each assessment underneath it). 

Tip: As you get more practiced at using the MTM 
Opportunity Dashboard you may learn to recognise 
more subtle patterns in the charts. 

Analysis 

Every no answer is a risk.  In most opportunities, any “no” 
can be overcome.  But as the risks pile up, the probability 
that this is not going to happen increases.  In any accident, 
more than one thing went wrong.  There is no exact science 
around how many no answers will destroy an opportunity, 
but they do provide a good measure of danger, and of the 
effort required to bring it home.  Risks need to be either 
removed or controlled to win. 

Every unknown answer is an uncertainty.  Uncertainty also 
adds up.  The more unknowns you have – especially as time 
runs out – the more you are flying blind.  You just don’t 
know if the opportunity is winnable or not.  Uncertainty 
needs to be reduced to make good decisions. 

Every yes answer is another step to closing the deal, another 
defence against competition, and another piece of evidence 
to get support. 

Now go back and reconsider the Percentage 
probability in row 23 and the Traffic Light in row 25. 
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Reviewing your dashboard 

It is tempting to think that, because the MTM Opportunity 
Dashboard is a spreadsheet, we could assign a score to each 
opportunity to pick which ones to focus our energies on.    

But the world is more complex than that.  Sales is not a 
science.   

The MTM Opportunity Dashboard allows you to get a view 
across them all.  It provides a formal objective framework 
for making decisions.   

But you (often with your manager) need to make those 
decisions.  No tool can do that for you. 

How often you review depends on how long your sales 
cycles are in your industry, how many opportunities you 
have, and where you are in your sales period (quarter, 
year…). 

All of these review comments apply equally whether it is 
your own personal portfolio of opportunities or those of 
your team – this tool works whether you are a sales person 
or a sales manager. 

Portfolio 

Manage each opportunity in the context of the other 
opportunities you have.  Don’t get too attached to any one 
opportunity - manage the health of the herd.  How does the 
overall portfolio look?   

Do you have enough strong opportunities?   

Will you make quota on what you have?  See cell C14 for 
“Total % quota” – what all your opportunities add up to as 
a percentage of your total quota, after they have been 
weighted by the expected probability of winning each deal.   
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Qualification 

Three qualification decisions to make in any review: 

• Should you qualify out of some opportunities? 

• How many? 

• Which ones? 

MTM helps with the last question. 

To pick your weakest opportunities, compare the graphs.  
With only a little experience and practice you will soon be 
able to see which ones to shed.  Look at these factors: 

How much overall green is there in the MTM Bars?  How 
much time left to fill them out some more?   

Is there any one row of the MTM Grid with lots of black?  
This means a big area of weakness, even if the other rows 
are all OK.  Without the MTM tool, it is easy to only see the 
“green” in an opportunity.  This tool makes you face up to 
the weaknesses.  Fix them or get real. 

Lots of black means work to do to remove or mitigate the 
risks.  Lots of orange means work to do to find out the 
answers.  Can it be done in the remaining time?  Or better 
to move on? 

Advances 

Where will you concentrate your efforts on the remaining 
opportunities?  Which opportunities and where within 
those opportunities? 

Does each risk/weakness you have identified need to be 
fixed or can you live with it? 

How much effort will you devote to these opportunities 
and how much to generating new ones? 
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Getting help 

Registration 

If you did not register when you downloaded the MTM 
Opportunity Dashboard from www.makethemostsales.com, 
you might like to do so now.  Amongst other things, this 
will notify you when there are new versions of the MTM 
Opportunity Dashboard or this MTM User Guide.  You 
will also get tips and ideas for using MTM. 

Community 

Registration also gets you access to the MTM community 
where you can link up with other MTM users and with us at 
Teal Unicorn to help you out with any issues you run into, 
to share ideas, and to discuss sales in general. 

Please remember to protect your company’s confidentiality 
when using this forum.  We accept no responsibility for 
anything you say, or for what you hear from others. 

Support 

We are a small company.  Other than the website, we 
cannot offer free individual support for MTM, sorry.  Paid 
support services are available on request at 
www.makethemostsales.com. If that link does not work for 
you, try www.tealunicorn.com/mtm. Or find us on twitter 
@rob_england @drcherryvu. 

 

http://www.makethemostsales.com/
http://www.makethemostsales.com/
http://www.tealunicorn.com/mtm
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What next 

As you get more mature in your use of Make The MOST 
you will want more information and advice.   

You can find sales training based on MTM at 
www.makethemostsales.com. 

http://www.makethemostsales.com/
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More stuff you can do 

If you look closely you will see each opportunity is made up 
of seven columns of the spreadsheet.  Always keep the 
seven together and work with them as a group. 

Sorting 

Because the spreadsheet uses multiple columns, with 
merged fields, you cannot sort the opportunities.  Sorry.  
Please contact us if this is an issue and we will consider a 
sortable version. 

Backing up 

For heaven’s sake, keep backup copies.  One way to do this 
is for the sales manager to require a copy emailed to them 
every week. 

Adding more opportunities 

Go to menu Home>Format>Protection (or right click the 
worksheet tab) and unprotect the sheet. 

Select seven columns that make up an opportunity (between 
a pair of vertical black divider lines).  It is important to get 
all seven, not just the five middle columns. 

Copy.   

Select the column just to the right of where you want to put 
a copy of them.   

Right click and “Insert copied cells”. 
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We recommend you protect the sheet again. 

Tip: don’t set a password on the sheet protection unless 
you really feel you need to.  If you do, please write it 
down somewhere. 

Deleting opportunities 

Because of the odd way that Excel does cell protection, you 
need to clear each block of white cells separately, sorry. 

We may add a button to each opportunity to do this in 
future.  We have avoided having macros in the sheet so far. 

Archiving opportunities 

Once opportunities are closed many of you will just want to 
delete them out.   You can print the dashboard off to keep a 
record on file, and all of the information here will usually be 
on record elsewhere. 

But if you want to preserve it, copy the seven columns, and 
paste them to the Archive worksheet. Excel will give an 
error about cell formulas but your data is preserved. 

 



27 

© Copyright 2009 Two Hills Ltd www.twohills.co.nz 

Forcing data 

Say you want to save a spreadsheet with “Today is” date 
fixed at some day.  Or you want to overtype the percentage 
of quota with a fixed value as it was at some point in time. 

Go to menu Home>Format>Protection (or right click the 
worksheet tab) and unprotect the sheet. 

Now you can change the value of any field. 

We recommend you protect the sheet again. 

Tip: don’t set a password on the sheet protection unless 
you really feel you need to.  If you do, please write it 
down somewhere. 

Collating spreadsheets 

If you are a sales manager you will probably want to 
maintain your own spreadsheet across all the opportunities 
of your team. 

You can copy and paste from their spreadsheet to yours, but 
consider transcribing the data manually instead.  This might 
seem tedious, but the text in the name field can be copied 
and pasted quickly.  By manually setting the flags for 
assessment and lifecycle, you take a quick moment to think 
about each one as you do. 

Customising the spreadsheet 

The Lookups worksheet of the spreadsheet controls all the 
thresholds and modifiable values.  It is hidden.  Go to 
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Home>Format>Hide&Unhide, or right click the worksheet 
tab. 

You can control when it gets excited about (colour codes) 
the value of a deal, as a percentage of quota 

Value of the deal:

small < 0.20 < medium < 0.50 < big

 

You can change when it alerts for number of days to go (or 
past) compared to the predicted close date 

Days to go:

very late < -90 < late < -30 < warning < 30 < OK

 

You can vary what to type in for yes 
or no.  For example for other 
languages, or some people prefer 

“+” and “-”. 

You can change the 
units of value 
(money) that the Quota and Value fields use.  This is just a 
text field that is used in the caption for Quota and Value – 
it doesn’t have any actual effect on 
any calculations.  You can change 
the currency symbol and/or the number of zeroes.  You fat 
cats may like to change it to “$M”.  

You can change 
the thresholds for 
colour-coding the 
summary counts of 
yes, no and 
unknown answers 

and the number of days out from the expected close date 
that we start counting the unknown answers 

Yes y

No n

 

Units of value $,000

Quota $,000

Y
e
s

U
n
k
n
o
w

n
s
 

N
o

> 20 10 10
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start counting unknowns 40 days out from close
 

 

You can even design your own 
lifecycle if you don’t like the names 
we gave to the seven steps 

 

 

 

 

Tip: Hide the sheet again when you are done. 

Tip: Customising these values may not be something 
you want all sales staff doing.  You can set a password 
on this worksheet.  Go to menu Tools>Protection and 
unprotect the sheet.  Select all cells in the sheet. Go to 
Format>Cells and set all cells to Locked.  Now go back 
to Tools>Protection and protect the sheet again – it will 
prompt for a password. 

Or more simply: ask them not to. 

 

sales lifecycle:

emotional

solution fit

business case

approval

signed

delivered

paid
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MtM Lite 

Does the dashboard seem too heavy for your selling? 
Perhaps your opportunities are smaller and faster moving, 
and you don’t have time to find out everything. 

Unprotect the Worksheet, and delete the questions that 
don’t make sense in your world. Then use it on a tablet or 
printed out to help you during an opportunity.  Don’t use 
the dashboard. 

You can still use the Worksheets to help you focus, to close 
more, and to review your portfolio. 
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Technical stuff 

The Make The MOST™ Opportunity Dashboard is a 
Microsoft Excel spreadsheet.  

The sheets are protected, but there is no password 
(except the cover page).    

It was created using MS-Office 2003, but the lack of any 
special features or macros means it should work with 
many earlier versions of MS-Excel and all later ones.  
The only complex features used are Validation Lists, 
Names and Conditional Formatting.  Please tell us if you 
find a version of MS-Excel that is not supported. 

Right now Google Sheets do not have enough features 
to support the Make The MOST spreadsheet. 

 

 

 


